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Document Overview 
This document provides a step-by-step guide to navigate the Provider Portal. 

Purpose of this Document 

The purpose of this document is to provide Provider Portal users with a reference document to successfully 

navigate and perform business processes included in Release 4.10 of the Provider Portal. 

Intended Audience 

The intended audience for this document includes provider staff responsible for completing profiles, contracts, 

enrollments, and attendance. 

What9s New in this User Guide? 

Corrected text for Registration Fees. 

Assistance 

If you have questions about any of the material in this user guide or about any processes not covered by this guide, 

please contact the Office of Early Learning Service Desk at Service.Desk@oel.myflorida.com or (850) 717-8600. 

mailto:Service.Desk@oel.myflorida.com
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Accessing the Provider Portal  
The link to access the Provider Portal is https://providerservices.floridaearlylearning.com. 

Creating a Provider Portal Account 
First-time Provider Portal users must register for an account to access the Provider Portal. Provider Portal users 

with multiple provider sites should begin by registering only one site location. This could be the provider9s primary, 
flagship or main location. Once a Provider Portal account registration request is approved for one provider site, the 

provider user will be able to create accounts for additional sites after logging on to the Provider Portal. 

 

Click the here link to start the new account registration process and the following page will display:  

 

 

A Provider Portal user must enter the taxpayer identification number (from the provider), the provider 

identification number (from the early learning coalition) and the Department of Children and Families (DCF) 

license, registration, exemption number or type the word <EXEMPT=. Providers may enter <EXEMPT= if they do not 
have an exemption number from DCF.   

The Provider Portal user must click the Verify License Details button to complete step 1 of the Provider Portal 

account registration process.  

 

 

 

 

 

https://providerservices.floridaearlylearning.com/
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If a match is found for the submitted information, the following message will display:  

 

If the information is not correct, click the No button and contact the local early learning coalition.  

If the information is correct, click the Yes button. On the next screen, the registration information will be 

populated by the system, with the exception of User Information. 

 

If a match is not found for the provider information, the following message will display: 
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After filling in the required information (noted with a red asterisk *), the Provider Portal user must click the 

Register button to complete the registration process. 
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After clicking the Register button, the following message may display:  

 

Click the Select this radio button to accept the standardized United States Postal Service (USPS) address or the 

Entered Address if the USPS Address is not found. Then, click the Apply button to continue. If the Provider Portal 

user clicks the Close button, the user will be taken back to the previous screen to re-enter the address information.  

Once the Provider Portal user submits an account request, the following page will display:  

 

The Provider Portal user should access the email address used in the account and find the email sent by 

DONOTREPLY@oel.myflorida.com. 

 

If the registration request is approved, the following email will be sent by DONOTREPLY@oel.myflorida.com.  
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The Provider Portal user can log on to the Provider Portal at https://providerservices.floridaearlylearning.com.  

Troubleshooting a Provider Portal Account Error Message 
If the Provider Portal user receives the following message, contact the local early learning coalition to verify that 

the taxpayer identification number matches the OEL database.  

 

If the Provider Portal user receives either of the following messages, contact the local early learning coalition to 

determine if a provider portal account has already been created.  

 

 

If the Provider Portal user receives the following message, contact the local early learning coalition to determine if 

the user name (email address) has been used in the Family Portal. The coalition may need to consult with OEL to 

make this determination. If a user name has been used in the Family Portal, even if an application was not created, 

OEL will have to remove the user name from the database so it can be used in the Provider Portal. If a provider has 

improperly used a user name to complete SR or VPK applications for a parent, the provider must contact that 

parent to get a replacement user name for that application so the provider9s user name can be used in the 
Provider Portal. Another option is for the provider to pick another user name to use in the Provider Portal.   

 

 

  

https://providerservices.floridaearlylearning.com/
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Provider Portal Returning User 

Log on Process 
Provider Portal users who have already created a user account can log on from the Provider Services welcome 

page by entering the user name and password created during the account process. Click the Log On button to 

continue. 

 

 

Password Recovery 
If the Provider Portal user cannot remember the password, the user can click the Forgot my password link. 

 

 

Clicking the Forgot my password link will display the following page: 
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The Provider Portal user must know the email address used for the account. Once the Provider Portal user enters 

an email address and clicks the Continue button, the following page will display: 

 

The Provider Portal user should then access the email account used for the account and find the email sent by 

DONOTREPLY@oel.myflorida.com. 

 

Once the Provider Portal user clicks the here link, the following page will display: 

 

 

The Provider Portal user must enter the user name (email address), new password and confirm the new password. 

After entering the required fields, click the Reset Password button to continue.  
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If the Provider Portal user successfully changes the password, the following page will display:  

 

Change Password Process 
A Provider Portal user can change the password at any point by clicking the Change my password link. 

 

Clicking the Change my password link will display the following page: 

 

The Provider Portal user must enter the User Name (email address), current password, new password and confirm 

the new password. After entering the required fields, click the Change Password button to continue. 
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If the Provider Portal user successfully changes the password, the following page will display:  
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Provider Dashboard 
After logging on to the Provider Portal, the following page will display:  

 

Update Provider Portal User Account Information 
Provider Portal users are able to update their user information 3 name and phone number 3 associated with their 

email address. If the name associated with an email address is blank, the user can add the first and last name. If a 

name associated with a standardized email address (e.g. Info@JimsHouseofSmarties.com) needs to be changed 

due to a director or other staff leaving, the first and last name can be changed as long as another user has access 

to that Provider Portal account. If no one has access to the Provider Portal account, contact your local early 

learning coalition to submit a ticket to the OEL Service Desk.  

Click on the gear icon. 

 

The following will display. Click the Account Information button.  

 

 

 

mailto:Info@JimsHouseofSmarties.com
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Enter the additional information and click Save.  
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Multiple Sites 
If the Provider Portal user registered a provider site that shares a taxpayer identification number with multiple 

sites, all of the sites with a shared taxpayer identification number will appear in a dropdown list for that Business 

Administrator.  

 

Manage Sites 
Providers with multiple site locations can use this feature to manage additional sites. Click the Manage All Sites 

link to add new provider sites. Additional sites can only be added if the sites share the same taxpayer identification 

number. This function will only be needed if the provider site is not found in the OEL database. Sites that share the 

same taxpayer identification number will automatically be assigned to the Business Administrator who registered 

the first provider site with the same taxpayer identification number.  
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After clicking the Add Site button, the following message will display:  

 

If the new provider site matches, the location information will be pre-populated.  

 

  



 21 

If the new provider site does not match, the location information must be entered by the Provider Portal user.  
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After clicking the Register button, the following message may display:  

 

Click the Yes button to accept the standardized United States Postal Service address. Click the No button to go 

back to the previous screen to re-enter the address information.  

Manage Users 
Click the Manage All Users link to edit, add, and inactivate provider site users.   
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To edit the role of a Provider Portal user, click the Edit button.  

 

Provider User Roles: 

ý Business Administrator 3 Able to edit the provider profile and principal business information that is 

shared among associated provider sites; able to add provider sites and users; submit profiles and 

profile updates; and create contracts. This role would typically be assigned to an owner.  

ý Site Administrator 3 Able to edit the provider profile associated to their site add provider users for a 

site, but cannot create a new site. This role would typically be assigned to a principal or director.  

ý User 3 Able to perform administrative tasks based on permissions granted by the Business 

Administrator or Site Administrator. This role would typically be assigned to teachers and aides.  

 

After changing the role, click the Save button to continue.  

 

To add a user, click the Add User button.  
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In the user name field, the Provider Portal user will enter the email address of the new user. If the user already has 

an account in the Provider Portal, the user role must be selected. Click the Save button to continue.  
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In the user name field, the Provider Portal user will enter the email address of the new user. If the user does not 

exist in the system, the user9s information and role must be entered. Click the Save button to continue.  

 

Once the new user has been added, an email will be sent to the new user by DONOTREPLY@oel.myflorida.com. 
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The User role has a set of permissions that can be individualized for each User. Each option is unchecked by default 

and must be checked to add to the User. Click the Save button to continue.  
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To inactive a user, which will remove the user from the site, click the Inactivate button.  

 

If the Provider Portal user discovers that an email address has an error after it has been entered, the user can add 

the correct email address by clicking the Add User button, entering the required information, and then click the 

Save button. Then, the user will click the Inactive button for the email address which has the incorrect email 

address. For example, from the above Manage All Users screen, if the Business Administrator9s email address was 
incorrectly entered as oeldemonstation@gamaial.com, the process would be to click the Add User button and 

create oeldemonstration+3@gmail.com, click Save, and then click Inactivate for oeldemonstation@gamaial.com. It 

is important to create the correct email address first before inactivating the incorrect email address.  

Broadcast Messages (not yet available) 
The Broadcast Messages section of the Provider Dashboard will display all messages sent by the local early learning 

coalition to all providers in the coalition service area. Click the message title to see the full text of the message.  
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Coalition Messages 
The Coalition Messages section of the Provider Dashboard displays messages sent by the local early learning 

coalition to a specific provider. This is a one-way communication; the provider cannot email the coalition directly 

from the portal. Click the message title to see the full text of the message.  

 

Frequently Used Links 
The Frequently Used Links section of the Provider Dashboard has links to web pages with information about 

statewide provider requirements, training and services. 
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Completing the Provider Profile 
After registering as a provider, the next step is to complete the Provider Profile.  

Request Assistance 
If a Provider Portal user needs assistance filling out any information in the Provider Profile, click the Request 

Assistance button.  

 

   
 

Then, complete the field, briefly describing the need for assistance. Click the Submit button to send the request.  

 

 
 

After clicking Submit, the following message will display:  
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The Provider Portal user will not be able to edit the profile once the request for assistance is submitted; however, 

coalition staff will be able to edit information in a profile while providing assistance to a Provider Portal user. 

 

The request for assistance can be cancelled by the Provider Portal user by clicking the Cancel Assistance Request 

button. 

 

. 

 

If a Provider Portal user cancels the assistance request, the following message will display and the user will 

complete the field, briefly describing the reason for cancelling the request. Click the Submit button to continue.  

 
 

After cancelling the request, the following message will display:  
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Business 
The Business Information page collects business information about the provider, including business name and 

address information, and it is shared among additional sites (if any). Only a Business Administrator may edit the 

information on this page.  

 

NOTE: This information was previously captured in the Business tab of the provider profile. Although the Business 

Information page is now separated from the provider profile, it must be completed before the profile may be 

submitted.  

Tool tips, indicated by the  symbol, are available to provide useful information to Provider Portal users about 

specific terms in the Provider Profile. Click the to see the message.  

To complete the Business Info page, click the Business dropdown menu from the Provider Dashboard.  

 
Then, click Business Info.  
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Profile 
A Provider Portal user must fill out all information in each tab, and click the Next button to continue filling out the 

provider profile information. Click the Back button to return to the previous tab. 

Tool tips, indicated by the  symbol, are available to provide useful information to Provider Portal users about 

specific terms in the Provider Profile. Click the to see the message.  

To complete the Provider Profile, click the Profile dropdown menu from the Provider Dashboard. 

 

Then, click Provider Profile.  

 



 34 

Yellow Warning Symbols 

Yellow warning symbols will appear on certain fields on the following tabs: General, Facility, Services, Curriculum, 

Staffing & Capacity, and Documents.  

If the Provider Portal user hovers over the yellow warning symbol, the following message will display.  

 

If a change is made, the coalition will review the change and change the profile status to Incomplete to allow the 

Provider Portal user to re-submit the VPK-APP. The user will receive the following email from 

DONOTREPLY@OEL.myflorida.com.  
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Step 1 3 General 
The General tab collects basic information about the provider, including provider types and whether or not there is 

interest in contracting with the early learning coalition to provide School Readiness or Voluntary Prekindergarten 

(VPK) Education services. 
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Step 2 3 Facility 
The Facility tab collects contact information for the provider. The Provider Portal user is required to enter contact 

information for staff responsible for different aspects of the business. If the staff person is an Authorized Contract 

Representative or VPK Authorized Contract Representative, click the checkbox below each section (Director, VPK 

Director, etc.).  
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When the Add New Contact button is clicked, the Provider Portal user can create additional provider contacts for 

the profile.  
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Step 3 3 Services 
The Services tab collects information on the ages of the children in provider care, as well as different provider 

services. 
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Step 4 3 Curriculum 
The Curriculum tab collects information about the provider9s curriculum. A provider may choose multiple curricula 

from the list. If the provider is a school readiness provider, an approved curriculum must be chosen. If no approved 

curricula are being used by the provider, the Provider Portal user should select <Other.= If a provider does not see 

their curricula listed, choose <Other= as the curriculum. 

 

 

Step 5 3 Fees & Discounts 
The Fees & Discounts tab collects information about fees the provider assesses the parent. The Provider Portal 

user should enter all applicable fees. All amount fields must have either a dollar amount or zero entered.  If a fee is 

not applicable, the amount entered must be <0.= If there are no family discounts offered, the selection must be 

<None.= 
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Step 6 3 Hours of Operation 
The Hours of Operation tab collects information on the type of schedules offered for care. The Provider Portal user 

must click the checkbox next to the desired day of the week before inputting hours of operation for that day. The 

default hours of operation for each day are 6:00 a.m.3 6:00 p.m. An Enhanced Schedule is available.  
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Step 7 3 Staffing & Capacity 
The Staffing & Capacity tab collects information on how many children the facility will or can care for. These 

questions are asked by age group. For each care level, the Provider Portal user should enter the highest number of 

teachers and children for all classrooms for each care level. This tab does not calculate staff-to-child ratios, but 

stores staffing and capacity numbers for local early learning coalition review.  

Staff-to-child Ratio is the number of children that an individual teacher is responsible for.  To reflect the actual 

ratio, the <Teachers in Classroom= column should always be 1.  For example, if you have 2 teachers with one class 
of 20, you should list 1 <Teacher in Classroom= with 10 <Children in Classroom= and a <Group Size= of 20.    If you 
follow the state mandated ratios for a center or facility, please see the example below.  You can omit the age 

groups you do not serve. 

Group Size is the maximum number of children, by age, that can be in a single classroom at any given time.  If you 

follow the state mandated group sizes for a center or facility, please see the example below.  You can omit the age 

groups you do not serve.   
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Example: Child Care Center 1 

This example uses the state mandated minimum staff-to-child ratios and maximum group sizes permitted for 

centers.  

 

Example: Child Care Center 2 

This example uses more stringent staff-to-child ratios and group sizes that are smaller than the state mandate for 

centers. 

 

For more information on staff-to-child ratios and group sizes for facilities, please visit the School Readiness Health 

and Safety Standards Handbook. 

http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
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Example: Family Child Care Homes 1 

A family day care home is allowed to provide care for one of the following groups of children, which includes 

household children under 13 years of age.  Below are examples of how to fill out this table using the state 

mandated minimum ratios.  

**The group size column should never exceed 10 for a family child care home. 

This example uses the maximum of four children from birth to 12 months of age.  

 

Example: Family Child Care Homes 2 

This example uses the maximum of three children from birth to 12 months of age, and other children, for a 

maximum total of six children.  
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Example: Family Child Care Homes 3 

This example uses the maximum of six preschool children if all are older than 12 months of age. 

  

Example: Family Child Care Homes 4 

This example uses the maximum of 10 children if no more than 5 are preschool age and, of those 5, no more than 

2 are under 12 months of age. 

 

  



 46 

Example: Large Family Child Care Homes 1 

A large family child care home is allowed to provide care for one of the following groups of children, which 

includes household children under 13 years of age. 

**The group size column should never exceed 12 for a large family child care home. 

This example uses the maximum of 8 children from birth to 24 months of age. 

 

Example: Large Family Child Care Homes 2 

This example uses the maximum of 12 children, with no more than 4 children under 24 months of age. 

 

For more information on staff-to-child ratios and group sizes for family child care homes please visit the School 

Readiness Health and Safety Standards Handbook. 

 

http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
http://www.floridaearlylearning.com/statewide-initiatives/health-safety/health-safety-checklists-handbooks-and-forms
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Step 8 3 Private Pay Rates 
The Private Pay Rates tab collects information on the provider9s private pay rate based on unit of care and care 
level. The Provider Portal user must enter in the private pay rates for each <Unit of Care= and <Care Level= offered 
by the provider. Shaded cells do not permit entry. If care is not provided for that Unit of Care and Care Level, no 

entry is needed.  

Providers that indicate they want to complete a contract to participate in the school readiness program on the 

General tab will also have a section on the Private Pay Rates tab to enter the Daily Rates for the School Readiness 

Program. The Provider Portal user may edit the $0.00 amount for each <Unit of Care= and <Care Level= offered by 
the provider or click on the SR Daily Rate Helper button. The Helper button will automatically calculate the rates 

based on the Full Time Monthly Rates or Full Time Weekly Rates, and the Part Time Weekly Rates entered in the 

Private Pay Rates section. The rates are also editable after calculation. These rates will be utilized in the 

contracting process if the provider enters into a School Readiness contract with an early learning coalition.  

NOTE: With Release 3.5, School Readiness providers must now answer a question regarding the family9s 
responsibility to pay the differential between the Approved Reimbursement Rate and the Private Pay Rate.     
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Step 9 3 Closures Calendar 
The Closures Calendar tab collects information on any days the provider will be closed. The Provider Portal user 

will select all closure days for the provider. Once selected, the date will change from white to blue. The local early 

learning coalition may define reimbursable holidays for the School Readiness program, which will be shaded gray. 

When a provider closure date and a coalition-defined reimbursable holiday are the same, the date will be shaded 

dark blue. A Provider Portal user does not need to include Saturdays and Sundays on the Closures Calendar if 

services are not provided on those days.   

NOTE: Actual reimbursable holidays will be selected during the contracting process if the provider enters into a 

School Readiness contract with an early learning coalition.  
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Step 10 3 Documents 
The Documents tab allows the Provider Portal user to upload documents for the local early learning coalition to 

review. Based on provider answers in the provider profile, the Documents tab will display types of documents that 

may be uploaded to support a contract to provide School Readiness or VPK services. Users may enter up to five 

documents for each document type. Documents uploaded in this tab will also populate in the Document Library 

and will be utilized during the contracting process.  
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Step 11 3 Review 
After reviewing the information for each section, the Provider Portal user must click the Next button to continue.  

 

 

    

& 
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Step 12 3 Sign and Certify 
To submit the Provider Profile, the Full Name must exactly match (and is case-sensitive) the name entered on the 

Manage Users page. The Provider Portal user must then check the <Check box to certify by electronic signature= 
check box and click the Submit button. 

 

 

Once the Provider Portal user submits the Provider Profile, the following page will display: 

 

The Provider Portal user should then find the email sent by DONOTREPLY@oel.myflorida.com. 
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Managing a Profile as a Provider Portal User 

Provider Dashboard 
On January 1 of each program year, a button will appear next to the current program year that will allow the 

Provider Portal user to migrate all profile information from the current program year to the next program year 

(except Closures Calendar dates). To migrate profile information to the next program year, the Provider Portal user 

will click the button. In this example, the provider is migrating profile information from the 2018 3 

2019 program year to the 2019 3 2020 program year. All information from the 2018-2019 profile will migrate to 

the 2019-2020 profile, with the exception of the Closures Calendar. The provider can also skip a profile year and 

still be able to create a profile for the current year. For example, the provider had a 2017-2018 profile, but skipped 

the 2018-2019 profile. In order to create a 2019-2020 profile, the provider will go to the 2017-2018 profile, click 

the Create 2018 button, then go to the 2018-2019 profile, and click the Create 2019 button. The skipped profile 

2018-2019 can remain Incomplete.  

 

 

After a provider is active, a Provider Portal User can edit the Provider Profile, by clicking the Profile dropdown 

menu and then clicking the Provider Profile button.  

 

Provider Portal users can manage School Readiness and VPK contracts from the Provider Dashboard.  
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Provider Portal users can manage School Readiness and VPK enrollments from the Provider Dashboard.  

                  

              

Provider Portal users can manage School Readiness and VPK attendance, as well as view reimbursement details for 

paid attendance rosters, from the Provider Dashboard.  

 

Provider Portal users can click the Documents dropdown menu to access the Document Library Management 

function and view and upload additional documents for coalition review.  
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Managing Contracts 
Provider Portal users can view contract statuses and edit/download contracts through the Manage Contracts 

function.  
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Managing Documents 
Documents can be added to the Document Library for coalition review. The folder list within the Document Library 

is standard for all providers, but coalitions have the ability to re-name or add new folders. Documents uploaded to 

the Documents tab of the provider profile will also populate in the Document Library; however, documents 

uploaded to the Document Library will not populate in the Documents tab of the provider profile.  

Viewing/Uploading Documents 

To view or upload documents in a folder, the provider portal user will click the View Files or Upload New File 

button, respectively.  
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Provider Portal users can move within the Document Library by clicking the Change Folder dropdown menu. Files 

can also be renamed within each folder by clicking the Rename File button.  

 

Enter the new file name in the New File Name field and click the Save Changes button to continue.  

 

Archiving Documents 

Click the Remove button to remove a document from the profile documents screen and archive it in the 

appropriate Document Library Management folder. 
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A Frequently Asked Questions pop-up message is available for the Provider Portal user. Contact the local early 

learning coalition if additional help is needed.  
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Provider Contracting 
NOTE: Provider contracts are populated by information in the Active profile. As a result, the profile is read-only 

once the contract status is Initiated, Incomplete, or Submitted. If any changes need to be made to the Active 

profile after a contract is initiated or there is an error found in the profile once the contract is being edited (the 

contract status is Incomplete), contact your early learning coalition.  

 

SR Contract 
After the coalition has initiated an SR contract, the user will navigate to Contracts > Manage Contracts from the 

Provider Dashboard.  

 

The Manage Contracts page displays. Click the Edit button for the initiated OEL-SR 20. 
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Provider Eligibility and Notification 

After clicking the Edit button, the following page displays. Review the options in the dropdown menus, update the 

provider representative information, if needed, and click Next Step to continue.  

 

Provider Responsibilities and Scope of Work 

If the provider is eligible to participate in the contracted slots program, the provider must select if they want to 

participate in the program. If the contracted slots program is not applicable, the option to participate in the 

contracted slots program is not displayed.  

If this question is displayed, make a selection, then click Next Step to continue. 
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Exhibit 1: Program Assessments 

After clicking the Next Step button, the Exhibit 1 page displays. If the provider is exempt from program assessment 

requirements, the provider must select if they want to waive the exemption. If the provider is not exempt, the 

option to waive exemption is not displayed. 

 

NOTE: If the provider is exempt from program assessments and selects <Yes= to waive the exemption, the contract 
will be sent back to the coalition for review.  
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Exhibit 1: Child Assessments 

On the Exhibit 1 page, select if the provider elects to conduct child assessments.  

 

If <Yes= is selected, a pop-up message appears for the provider to confirm that they have/will upload the reliability 

certification.  
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If the provider selects <Yes= to conduct child assessments, select a child assessment tool. Click Next Step to 

continue.  
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Exhibit 3: Quality Improvement Plan Selection 

After clicking Next Step, the Exhibit 3 page only displays if the provider is required to participate in a quality 

improvement plan. Enter the user9s initials in each box that has a check mark, then click Next Step to continue.  
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Exhibit 5: Provider Reimbursement Rates 

If the provider charges an annual registration fee (Profile > Provider Profile > Fees & Discounts), the following 

page displays. Select the annual fee details, then click Next Step to continue. 

NOTE: If <Month= is selected, another dropdown field appears for the provider to select a month. If <Other= is 
selected, the provider must provide a description. 

 

 

Exhibit 6: Holiday Schedule 

After clicking Next Step, the following displays. The dates are based on any coalition-defined holidays and the 

closure dates from the profile Closure Calendar.  

If fewer dates are listed than the coalition maximum total paid closure dates, additional provider holidays can be 

added to the holiday schedule exhibit if applicable.  Click the Edit button on the holiday table. 
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After clicking the Edit button, a pop-up window appears with an editable holiday table. On a blank row, enter the 

holiday name, then select a date from the dropdown in the Date column. Duplicate dates cannot be used. When 

done editing, click Save. Then, click Next Step to continue. 

 

Preview Contract 

Prior to executing the contract, click Preview Contract to view the contract. This allows the user to view all the 

information input into the contract and exhibits from the profile. Information added by the coalition and provider 

should be reviewed as well.  
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After clicking the Preview Contract button, the following displays in a new browser tab.  

 

Contract Execution 

To electronically sign the contract, check the By Electronic Signature checkbox.  

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract, the contract can 

be downloaded as a .pdf and printed. An authorized representative should electronically sign and submit the 

contract.  
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After clicking the checkbox, the following message displays. Enter the Title of Signator, then click Yes.  

NOTE: The Title of Signator is not the provider9s name, but the business title, e.g. Owner, Director, Principal.  

 

After clicking the Yes button, the electronic signature of the signatory, printed name, title, and the date/time will 

populate, highlighted in yellow. Click Next Step to continue.  

NOTE: The electronic signature and printed name of the user is based on the user who is logged on to the portal. 

Please ensure that the proper user is logged on to electronically sign the contract. If the incorrect name is used for 

the electronic signature, the checkbox can be un-checked. 
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Contract Certification 

After clicking the Next Step button, the following page displays. Enter the full name of the user who is logged on, 

title, and click the Certified by electronic signature checkbox. Click Submit.  

 

After clicking the Submit button, the following message will display and an email will be sent by 

DONOTREPLY@OEL.myflorida.com. 
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Navigate to the provider manage contracts page (Contracts > Manage Contracts). The SR contract will have a 

status of Submitted for the coalition to review.  
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VPK Contract 
After the coalition has initiated a VPK contract, the user will navigate to Contracts > Manage Contracts from the 

Provider Dashboard.  

 

 

The manage contract page displays. Click the Edit button for the initiated OEL-VPK 20. 
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Compensation and Funding: Advance Pay Options 

After clicking the Edit button, the following page displays. When the user9s pointer hovers over the dropdown 
fields, a tool tip informs the user that the advance payment selections will apply to all sites on the contract.  

Select an Advance Payment Option for the school year and summer programs. Click Next Step to continue.  
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Exhibit 1: Provider Location List Attachment 

After clicking the Next Step button, the following displays. Select the School Year and/or Summer checkbox if the 

session is offered. Click Next Step to continue.  

 

Preview Contract 

Prior to executing the contract, click Preview Contract to view the contract. This allows the user to view all the 

information input into the contract and exhibits from the profile. Information added by the coalition and provider 

should be reviewed as well.   
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After clicking the Preview Contract button, the following displays in a new browser tab.  
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Contract Execution 

To electronically sign the contract, click the By Electronic Signature checkbox.  

NOTE FOR PUBLIC SCHOOLS: If a school board or school district needs to manually sign a contract, it can be 

downloaded as a .pdf and printed. 

 

After clicking the checkbox, the following message displays. Enter the Title of Signator, then click Yes.  

NOTE: The Title of Signator is not the provider9s name, but the business title, e.g. Owner, Director, Principal.  
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After clicking the Yes button, the electronic signature of the signatory, printed name, title, and the date/time will 

populate, highlighted in yellow. Click Next Step to continue.   

NOTE: The electronic signature and printed name of the user is based on the user who is logged on to the portal. 

Please ensure that the proper user is logged on to electronically sign the contract. If the incorrect name is used for 

the electronic signature, the checkbox can be un-checked. 
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Contract Certification 

After clicking the Next Step button, the following will display. Enter the full name of the user who is logged on, 

title, and click the Certified by electronic signature checkbox. Click Submit.  

 

 

After clicking the Submit button, the following message will display and an email will be sent by 

DONOTREPLY@OEL.myflorida.com. 
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Navigate to the provider manage contracts page (Contracts > Manage Contracts). The SR contract will have a 

status of Submitted for the coalition to review.  
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VPK-APP 
The VPK-APP replaces forms OEL-VPK 10 (Provider Application), OEL-VPK 11A (Class Registration 3 Instructors), and 

OEL-VPK 11B (Class Registration 3 Calendars). The tabs must be done in order of appearance (Attendance Policy, 

then VPK Director, etc.); the answers in one tab populate information in the next tab.  

After the coalition has initiated the provider application, the Provider Portal user will click Manage Contracts from 

the Provider Dashboard.  

 

The following will display. Click the Edit button to review the contract. 

 

 

Step 1 3 Attendance Policy 

The Attendance Policy tab allows the Provider Portal user to upload the provider Attendance Policy. The document 

that is to be distributed to parents must be uploaded by clicking the Browse button, finding the document in the 

electronic files and clicking the Upload button.  
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Step 2 3 VPK Director 

The VPK Director tab allows the Provider Portal user to add information and upload documents for the primary 

VPK Director that will be listed on the OEL-VPK 10. Click the Add New Director button to begin.  

 

Click the Save button after all information is entered for the director.  

 

NOTE: The Credential Type, Credential Certificate Number, Credential Issue Date, and Credential Expiration Date 

will not appear for public schools.   

Once the VPK Director is added, the supporting documents may be added by clicking Edit.  
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The Provider Portal user will select the document type, browse to select a file, enter the document issue or 

expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.  

 

Step 3 3 VPK Instructors 

The VPK Instructors tab allows the Provider Portal user to add information and upload documents for each 

instructor. Click the Add New Instructor button to begin.  

 

Click the Save button after all information is entered for each instructor.  
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Once the VPK Instructor is added, the supporting documents may be added by clicking Edit.  

 

The Provider Portal user will select the document type, browse to select a file, enter the document issue or 

expiration date (if applicable), and click Upload. Then, click Save. At least one document should be uploaded.  

 

NOTE:  If a VPK Instructor achieves new certifications and moves from a sub to an aide, create a new record for 

that Instructor. If the Instructor Type is only changed from sub to aide, the maximum class size will not increase to 

20 in a class that already has a Lead Instructor.   

Step 4 3 VPK Calendars  

The VPK Calendars tab allows the Provider Portal user to provide information regarding each unique class calendar 

which will be offered at the VPK site. If classes are offered at identical times on identical dates, they utilize the 

same class calendar (e.g., all classes are scheduled from 8:00am to 11:00am, Monday through Friday, starting on 

January 11). If classes are not offered at identical times on identical dates, they utilize unique class calendars which 

must be created separately. Click the Add New Calendar button to begin.  

 

The Calendar ID will automatically populate with a letter beginning with A.  Each additional calendar will receive a 

sequential Calendar ID. 

The Calendar Name is an optional field.  It may be used for a short nickname such as <Fall AM.= 
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The program type selection of School-Year (540 hours) or Summer (300 hours) is required.  The program selected 

will determine the valid calendar date range.  The Calendar Start Date and Calendar End Date must be within the 

valid calendar date range. The Calendar Start Date and Calendar End Dates should reflect the first day VPK 

instruction will be delivered and the final day VPK instruction will be delivered. 

Next, the instructional days, start time and end time must be added by checking the box by the days of the week 

that VPK instruction will be delivered and entering the times of VPK instruction for the days of the week that VPK 

instruction will be delivered.  

 

After the instructional days, start time and end time are added, the Total Calculated Hours and Total VPK 

Instructional Days sections will populate. 

 

Providers are to use the calendar to note any non-instructional days on which VPK instruction will not be delivered 

(such as vacations or holidays) and exceptions to normal instructional days that occur during the defined calendar 

start and end date.  Entering Non-Instructional Days and Instructional Day Exceptions can increase or decrease the 

Total Calculated Hours.   
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For example, if the Total Calculated Hours exceed 300 hours for the summer program type or 540 hours for the 

school-year program type (as shown in the example above), the user may remove a day (or more) by labeling it a 

Non-Instructional Day.  Each Non-Instructional Day entered will deduct the hours assigned to that day, thereby 

decreasing the Total Calculated Hours. Instructional Day Exceptions can be used to change the hours assigned to 

that day (to increase or decrease the hours).  For example, if the calendar is a few hours short, an instructional 

day9s hours may be extended to increase the Total Calculated Hours.  To add a Non-Instructional Day or an 

Instructional Day Exception to the calendar, click on that date on the calendar. Multiple days can be selected by 

clicking and dragging across multiple days on the calendar.  

 

 

After clicking on a date, a pop-up message will appear.  The Provider Portal user must select the Event Type and 

enter a short description. When an Instructional Day Exception is selected, the user must also enter the time range 

for the day. 

 

Click the Update button to save changes. Click the Remove button to remove an existing Non-Instructional Day or 

Instructional Day Exception created on the calendar. 
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When the Total Calculated Hours match the hours for the VPK program type, the user will click the Save button.  

 

NOTE: The hours must equal, or be fewer than, 300 hours for the summer program type or 540 hours for the 

school-year program type for the calendar to save. 
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Step 5 3 VPK Class(es) 

The VPK Class(es) tab allows the Provider Portal user to build VPK classes and assign instructor(s) to them. Click the 

Add New Class button to begin.  

 

The Class ID will automatically populate after the Class Calendar is selected.  The Class ID is created using a 

sequential letter beginning with A.  In the second space, either an <F= for school-year (fall) or <S= for summer will 
appear.  The F and S is derived from the calendar9s program type. The last two digits represent the last two 
numbers of the program year.  Each additional class will receive a sequential Class ID.   

The Class Name is an optional field.  It may be used for a short nickname such as <Blue Room.= 

The Main Curriculum drop down is populated with selections made from the provider9s profile. 

The Class Start Date and Class End Date are populated with the Calendar Start Date and End Date.  

The Instructors are populated with individuals from the VPK Instructors tab. Check the checkbox in front of the 

instructor to add them to the class, then enter the Instruction Start Date. If the class has not started, the 

Instruction Start Date defaults to the Class Start Date. For each class, one Lead Instructor must be selected. Click 

the Save button after all information is entered for each class. 
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Step 6 3 Review  

During the review process, the Provider Portal user can click the Edit button to make any changes to a section. 

After reviewing the information for each section, the user must click the Certify and Submit tab button to 

continue.  
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Step 7 3 Certify and Submit 

To submit the VPK-APP, the Signer9s Name must exactly match the name entered in the Provider Profile, the 
Provider Portal user must fill in the phone number, check the <Check box to certify by electronic signature= check 
box and click the Submit VPK Provider Application button.  
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Updating a VPK-APP 
A Provider Portal user can edit a VPK-APP by clicking the Edit button on their Manage Contracts page. Clicking the 

Download button will export the information in the VPK-APP to a .pdf document.  

 

VPK Director 

To edit the current director9s information in the VPK Director tab, click the Edit button. To remove a director, click 

the Remove button. To add a new director, click the Add New Director button. To edit the current supporting 

document, or add a new document, click the Edit button.  

 

When the Remove button is clicked, the following message will display.  

 

Once the director9s last day is entered and the Remove button is clicked, the director will no longer appear on the 

VPK Director screen, unless the Show removed directors checkbox is checked. The director can be re-added by 

clicking the Re-add button.  
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VPK Instructors 

To edit the current instructors9 information in the VPK Instructors tab, click the Edit button. To add a new 

instructor, click the Add New Instructor button. To remove an instructor, click the Remove button. To edit the 

current supporting document(s), or add a new document, click the Edit button.  

 

 

If the instructor has not been assigned to a class, when the Remove button is clicked, the following message will 

display.  
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Once the Remove button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the 

Show removed class instructors checkbox is checked. The instructor can be re-added by clicking the Re-add 

button.  

 

 

If the instructor has been assigned to a class, when the Remove button is clicked, the following message will 

display.  

 

To remove an instructor from a class, go to the VPK Class(es) section and click the Edit button for the class.  
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In the Instructors area, uncheck the instructor9s name. Once un-checked, enter the Last Taught Date, or click the 

Never began instruction of class checkbox if the class has not started. Click Save. 

 

The VPK Classes tab will now show that the instructor is removed from the class. 

Now that the instructor is no longer assigned to any class, the Provider Portal user may go to the VPK Instructors 

tab to remove the instructor by clicking Remove. The following message will display: 
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Once the Remove button is clicked, the instructor will no longer appear on the VPK Instructors screen, unless the 

Show removed class instructors checkbox is checked. The instructor can be re-added by clicking the Re-add 

button.  

 

The Review tab is also updated with the Instructor removal information. 

 

 

 

 

 

  



 95 

VPK Calendars 

To edit the current calendar in the VPK Calendars tab, click the Edit button, make any necessary edits, and click the 

Save button. To remove a calendar, click the Remove button. To add a new calendar, click the Add New Calendar 

button. 

 

 

If there are no classes assigned to a calendar, when the Remove button is clicked, the following message will 

display.  

 
 

If there are classes assigned to a calendar, the following message will display: 
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Once a calendar is removed, the calendar will no longer appear on the VPK Calendars screen, unless the Show 

removed calendars checkbox is checked. The calendar can be re-added by clicking the Re-add button.  

 

 
 

NOTE: Calendar End Dates and Class End Dates are editable.  

 

The Calendar End Date can be changed to reflect changes in Non-Instructional Days or holidays that are added 

after the calendar begins. Changing the Calendar End Date will update the Class End Date and the Instructor Last 

Taught Date.  
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After the calendar is changed, if the provider needs to change the Instruction Start Date of an instructor, the 

provider will un-check and re-check the checkbox for each instructor and edit the date.  
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The Calendar Name can be added if the provider did not add a Calendar Name when the calendar was created.  
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VPK Class(es) 

To edit the current class information in the VPK Class(es) tab, click the Edit button. To add a new class, click the 

Add New Class button. To remove a class, click the Remove button. After all edits have been made for each class, 

click the Save button.   

 

 

Classes that have started may not be removed. Limited editing is available. 
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If the class has not started, when the Remove button is clicked, the following message will display:  

 
Once the Remove button is clicked, the class will no longer appear on the VPK Class(es) screen, unless the Show 

removed classes checkbox is checked. 
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To end the class, click the Edit button and the change the Class End Date to reflect the last day that VPK instruction 

was provided. The Instructor Last Taught Date will be updated to the Class End Date after clicking the Save button. 

 

 
 

The Review tab will now reflect the updated class information. 
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Editing an SR Contract Amendment   
Navigate to Contracts > Manage Contracts.  

 

 
 

The Manage Contracts page for the provider displays. Click the plus sign (1) to the left of the SR contract to be 

amended to expand the amendment sub-section. The amendment is in Initiated status. Click the Edit button (2).  

 
NOTE: The amendment status changes from Initiated to Incomplete while the amendment is being edited. 
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Review the Provider Eligibility and Notification sections, and enter changes to the provider contact information (if 

applicable), then click Next Step.  

 

 

If a change is needed to the provider9s selection to conduct child assessments or the child assessment tool has 
changed, make the new selections and enter the reason for modification. Click Next Step to continue. 
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The Quality Improvement Plan (QIP) Selection page displays if the coalition selected a new QIP strategy. Initial the 

Quality Improvement Plan strategy, if this page is displayed. Click Next Step. 

 

If the provider charges an annual registration fee, the registration fee page displays. If a change is needed to the 

annual fee assessment frequency, make a new selection. Click Next Step to continue. 
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The Exhibit 6: Holiday Schedule page displays. Click the Edit button for the provider and add or remove holidays in 

the edit window if applicable, then click Save.  Click Close to close the window. 

 

 

To proceed to the next page, click Next Step. 
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On the Amendment Signatures page, click the box to sign the amendment electronically. Provider may want to 

preview the OEL-SR 20A form to verify changes before signing and submitting.         

 

When the electronic signature box is checked, a pop-up window displays. Enter the Title of Signator, then click Yes 

to proceed with electronically signing the amendment, or click Cancel to close the window without signing.    
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When Yes is clicked, the signator9s signature, printed name, title and the date are populated and saved. Click 
Submit. 

 

NOTE: To add an additional signature, click Cancel and have the other Signator log in to sign the amendment 

before submitting. To remove the provider9s signature before submitting the amendment, uncheck the By 
Electronic Signature box and click Yes in the confirmation pop-up window.  
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Enter Full Name and Title, then click the <Certified by electronic signature box.= Click Submit. 

 

The successfully completed, signed, certified, and submitted message appears. 
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Viewing a Certified SR Contract Amendment 
Navigate to Contracts > Manage Contracts.  

 

 
 

The Manage Contracts page displays. Click the plus sign (1) to the left of the SR contract that was amended to 

expand the amendment sub-section. The amendment is in Certified status. Click View (2).  

 
 

The OEL-SR 20A opens in a new tab to view and print to PDF. 
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Editing the VPK Contract Amendment 
Navigate to Contracts > Manage Contracts. 

 

 
 

The Manage Contracts page for the provider displays. Click the plus sign (1) to the left of the VPK contract to be 

amended to expand the amendment sub-section. The amendment is in Initiated status. Click Edit (2).  

 
 

NOTE: The amendment status changes from Initiated to Incomplete while the amendment is being edited. 
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The Compensation and Funding page displays. The advance payment selections default to the current selections 

on the VPK contract or latest amendment. If applicable, change the advance payment option for the school year 

and/or summer programs. Click Next Step to continue. 

 

  
  

 

NOTE: For VPK contracts with multiple sites, changing the advance payment selection will affect all sites on the 

contract. If you are a provider on a multiple-site contract and you intend to change the advance payment 

selection(s) for this site but not all sites, contact your coalition to be removed from the contract. A separate VPK 

contract will need to be executed for the provider site that is removed from the contract. 

If a provider is being added to or removed from the contract, the Exhibit 1 Provider Location List Attachment 

displays. Select school year and summer as applicable, then click Next Step. 
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On the Amendment Signatures page, click the box to sign the amendment electronically. Provider may want to 

preview the OEL-VPK 20A amendment to verify changes before signing and submitting.         

 

When the electronic signature box is checked, a pop-up window displays. Enter the Title of Signator, then click Yes 

to proceed with electronically signing the amendment, or click Cancel to close the window without signing.    
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When Yes is clicked, the signator9s signature, printed name, title and the date are populated and saved. Click 
Submit. 

 

NOTE: To add an additional signature, click Cancel and have the other Signator log in to sign the amendment 

before submitting. To remove the provider9s signature before submitting the amendment, uncheck the By 
Electronic Signature box and click Yes in the confirmation pop-up window.  

Enter Full Name and Title, then click the <Certified by electronic signature box.= Click Submit. 

 

  



 114 

The successfully completed, signed, certified, and submitted message appears. 

 

 

Viewing a Certified VPK Contract Amendment 
Navigate to Contracts > Manage Contracts. 

 

 
 

The Manage Contracts page displays. Click the plus sign (1) to the left of the VPK contract that was amended to 

expand the amendment sub-section. The amendment is in Certified status. Click the View button (2).  

 
 

The OEL-VPK 20A opens in a new tab to view and print to PDF. 
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Enrollments - VPK 
VPK Providers may manage VPK enrollment online by going to Enrollments> Manage VPK Enrollments.  Two 

options are available:  Request/Change Enrollment and Bulk File Upload.  

 
 

Request/Change Enrollment 
 

This feature allows VPK Providers to request or change enrollment for children in verified classes submitted 

through the VPK Provider Application.  To begin, select the VPK Program Year, VPK Session, and VPK Class.   

 

 
With the VPK Program Year, VPK Session, and VPK Class selected, the class start date and end date appear as well 

as the max class size.  This information is directly tied to the VPK Provider Application.  For example, if there is one 

lead instructor for the school-year session submitted and verified on the VPK Provider Application, the max class 

size will be 11; if there are two instructors for the school-year session submitted and verified on the VPK Provider 

Application, the max class size will be 20. 

 

Next, the VPK children count and Non-VPK children count are displayed.  These two counts (summed together) 

cannot exceed the max class size.  The Non-VPK children count is used to anonymously indicate private pay 

children participating in the VPK class.  The Non-VPK children count defaults to zero.  When the Non-VPK children 

count is used, the number of VPK children permitted in the class is reduced to maintain the max class size limit.   
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The class roster records are also displayed. If there are no children enrolled in the class, a <No records found for 
this class= message displays.  

  

 
 

If there are/were children enrolled in the class, the records are listed with the current enrollment status (Enrolled, 

Enrolled-Change Requested, or Enrollment Ended (Terminated)).  

 

 
 

Enrolling a VPK Child 

Using the child9s approved Certificate of Eligibility (COE) provided by the family, enter the Certificate Number, Child 
First Name, Child Last Name, and Child DOB.  Then, click Enroll to this Class.   

 

NOTE: The fields are not case sensitive; however, the certificate number must be entered exactly as it appears on 

the COE (i.e. VPK####-YYYY). 
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The system verifies that the information entered matches a child with an approved COE for the VPK program year 

selected and that the child is not already enrolled (or in a non-eligible status for enrollment).   

NOTE: The county on the COE does not have to match the provider9s county because the child has been deemed 
eligible to participate in the VPK program.  The enrollment process automatically updates the child9s county for 
service to the provider9s county so the corresponding early learning coalition may manage the child9s enrollment 
with the provider.   

When a matching child is found and validations checks are successful, a confirmation message appears.  To 

continue, click Yes. 

  

Next, the system asks for the Anticipated Start Date.  This is the date the child will begin attending class.  Typically, 

this is the class start date unless the child is starting after the class begins.   

NOTE: An anticipated start date cannot be before the class start date or after the class end date.  And, an 

anticipated start date cannot be before the child's COE issue date (as displayed on the child9s COE and listed in the 
enrollment window).  
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The system validates each enrollment request to make sure the max class size is not exceeded (based on the 

number of instructors assigned, the VPK session type, and current class enrollment count).  To continue, click 

Enroll Child.   

 

When the enrollment request is successful, the child appears on the class9s enrollment roster as <Enrollment 
Submitted" and the coalition receives the enrollment request for review/approval/rejection.  In addition, the 

family receives a notification that their child9s enrollment is in progress.   

 

While the enrollment request is being processed by the coalition, the status is updated on the enrollment roster.  

For example, the coalition has changed the status to Coalition Reviewing.  

 

If the coalition rejects or cancels the enrollment request, the child will no longer appear on the class roster.  The 

VPK Director and family will receive an email notification.  The family is instructed to download their child9s COE 
from the Family Portal and re-start the enrollment process.   
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When the enrollment process is approved by the coalition, the child9s status is Enrolled. 

 

Managing VPK Enrollment 

The class roster has several features for managing enrollment.  Providers may change the anticipated start date, 

request to move the child to another class, remove the child entirely from the roster because they never attended, 

or request a termination of services. 

Change Anticipated Start Date 

To change the child9s anticipated state date, click Change within the Anticipated State Date column.  A window 

displays.  The current start date populates in the From field; enter the new start date in the To field.  This feature 

does not require coalition approval.  Click Save to commit the new date or click Close to abandon the date change 

and close the window.  This feature is available until the actual start date is recorded through the attendance 

process.  When the actual start date is populated in the column, the Change button is no longer available.   

 

Class Change 

Once the child's status is Enrolled, a class change may be requested.  To change the child9s class, click Class Change 

within the Actions column.  A window displays.  The current class populates in the From field; select the new class 

in the To field and enter the Transfer Effective Date.  The Transfer Effective Date should be the first day the child 

will attend the new class.  This feature requires coalition approval.  Click Submit Request to send the request to 

the coalition or click Close to abandon the class change and close the window.   

NOTE: Once a class change request is submitted to the coalition, a subsequent class change request for the same 

child is not allowed until the initial class change request is processed by the coalition.  



 120 

 

Now that the class transfer request is submitted, the child appears on the roster for both classes.  In the From 

class, the child9s status is Enrolled.   

 
In the To class, the child9s status is Enrolled - Change Requested.  

 

When approved, the From class has a termination effective date (same as the transfer effective date).  If the 

termination effective date has not passed, the status is Enrolled.  When the termination effective date occurs, the 

status will be Enrollment Ended.  No further actions can be taken on this enrollment. 

 

 



 121 

When approved, the To class is Enrolled with an anticipated start date and actual start date (same as the transfer 

effective date). 

 

NOTE: A class transfer request cannot be submitted for a child if the transfer effective date overlaps an existing 

enrollment period for that child. If the transfer effective date is BEFORE the termination effective date of the last 

enrollment, an error message appears, <The class transfer effective date overlaps an existing enrollment period for 
this child." 

When rejected, the request no longer appears in the To class.  The child remains enrolled in the From class. 

Class Change to a Full Class 

If a provider wants to move a child from class BF18 to class AF18, but class AF18 is full, the class change can still be 

done.  

 

Class BF18 is not full.  
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Class AF18 is full.  

 

 
 

The provider wants to move Blue Fairy Latham to AF18 from BF18.  

 
  



 123 

The provider selects AF18 in the To field and enters the Transfer Effective Date. Once the Submit Request button is 

clicked, the provider receives a red message.  
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Now, the provider can either select a class that is not full, or select a child to swap with in the full class. Click the 

Submit Request button to complete the class change.  
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Never Attended 

To remove a child from a class completely because they never attended, click Never Attended within the Actions 

column.  A window displays.  This feature does not require coalition approval.  Click Yes to remove the child or click 

No to abandon the removal and close the window.  Removing an enrollment changes the record9s status to 
Enrollment Cancelled and the enrollment process starts over for the family.  The provider9s VPK Director will 
receive an email notification to inform them the enrollment is removed; no attendance or reimbursement may be 

sought.  The child9s record is no longer listed on the class enrollment roster or attendance roster in the Provider 
Portal.  The family will receive an email notification to inform them the enrollment for their child was cancelled; 

instructions are provided to log into the Family Portal to download the child9s COE and select another VPK 
provider. 

This feature is available until the actual start date is recorded through the attendance process.  When the actual 

start date is populated in the column, the Never Attended button is no longer available.   

   

NOTE: Be very careful with the Never Attended feature.  If the intention is to transfer the child to a different 

classroom, use the Class Change feature.  If the child attended class, VPK instructional hours were used, and 

reimbursement is needed, use the Terminate feature. 
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Terminate 

To terminate a child9s enrollment, click Terminate within the Termination Effective Date column.  A window 

displays.  Enter the last day that services will be/were rendered and select the reason for termination.  The 

Termination Effective Date is displayed below the Last Day of Services as one day after the last day of services.  

Therefore, the Termination Effective Date is the first day the child is NOT attending class.  This feature requires 

coalition approval.  Click Submit Request to send the request to the coalition or click Close to abandon the 

termination request and close the window.   

 

NOTE: A child9s enrollment cannot be terminated before the class start date. If the provider enters a date in the 
Last Day of Services that is BEFORE the class start date, an error message appears, <Termination effective date 

cannot be prior to the class start date. If the child never attended, click the Never Attended button to cancel the 

enrollment.= Either enter a termination date that is after the class start date (and on or after the COE issue date), 

or click Close to abandon the termination request and close the window. 

When the termination request is submitted, the child appears on the class9s enrollment roster as <Enrolled - 
Change Requested.=  The coalition will receive the termination request for review/approval/rejection.   

 

When the termination request is approved and the termination effective date has not passed, the status is 

Enrolled.  When the termination effective date occurs, the status will be Enrollment Ended.  No further actions can 

be taken on this enrollment. 
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When rejected, the child remains enrolled in the class. 

 

VPK Bulk Enrollment Process 
In addition to the enrollment method described in <Enrolling a VPK Child,= providers may submit enrollment 
requests to the coalition via a file process.  To begin, click the Bulk VPK Enrollment tab.  The bulk file processing 

page displays. 

 

Next, click on the link to download the CSV file template.  The file may appear at the bottom of the computer 

screen depending on the user9s browser.  

 

Open the file and expand the columns.  Each column is explained below. 
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A. Provider ID = this is the provider ID for the site displayed on the Provider Portal home page/dashboard. 

 

B. Certification Number = this is the child9s certificate number listed on their COE.  The field is not case 
sensitive, however, the certificate number must be entered exactly as it appears on the COE (i.e. 

VPK####-YYYY). 

 
C. Child First Name = this is the child9s first name listed on their COE.  The field is not case sensitive. 

 

D. Child Last Name = this is the child9s last name listed on their COE.  Do not include a suffix (if any). The field 
is not case sensitive. 

 

E. Child DOB (MM/DD/YYYY) = this is the child9s date of birth listed on their COE.  The field will accept 

M/D/YYYY as well. 

 

F. VPK Program Year = this is the child9s approved VPK program year listed on their COE.  The field is looking 
for the first 4-digit year only.  For example, if the VPK program year is 2017-2018, the entry would be 
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2017.  Generally, the 4-digit VPK program year matches the year included at the end of the child9s COE 
number.   

 

G. Class ID = this is the desired class9s 4-digit ID.  The class ID must be entered as the 4-digit assigned ID.  Do 

not include the class name (if any).  Looking at the example below, the entry would be <AS17= not 
<Songbirds= or <AS17-Songbirds.= 

 
 

 

H. Anticipated Start Date (MM/DD/YYYY) = this is the date the child will begin attending class.  Typically, 

this is the class start date unless the child is starting after the class begins.   

NOTE: An anticipated start date cannot be before the class start date or after the class end date.  And, an 

anticipated start date cannot be before the child's COE issue date. The field will accept M/D/YYYY as well. 

 

I. MSID (XX-XXXX) = this field is for public schools only.  Public schools may enter their Master School 

Identification (MSID) number in a 6-digit format, where the first 2 digits are the district number followed 

by a hyphen and 4-digit school number.  The MSID number can be used in lieu of the Provider ID in 

column A.  Both IDs are accepted. 

When the file is complete, name it and save it as a CSV file type.   

NOTE: It may be helpful to include your provider name and class in the file name if troubleshooting is ever 

necessary. 
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When changing the file format to CSV, Excel often displays a message to ask if you want to keep using that format.  

If this message appears, click Yes. 

 

Click the Upload button.  A window displays.  Select your file and click Open.  

 

The file upload will begin.  The file details will populate on a row and turn green.  Click the Refresh button to 

populate the results. 

 

The file details will be updated.  The file size, total records count, committed records count, failed records count, 

processed time, status, and final results are updated.  The file results are also returned and can be downloaded by 

clicking on the Download button.   
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In this example, there is one failed record and three committed records.  The file download will include the error 

message and status for each record submitted.  The three committed records are now <Enrollment Submitted= and 
the failed record was not included because of an invalid date of birth.  The same validations that occur with a 

manual child enrollment occur with the bulk enrollment file process.  

 

The three committed records are displayed on the class9s enrollment roster as <Enrollment Submitted" and the 

coalition receives the enrollment requests for review/approval/rejection.  In addition, the family receives a 

notification that their child9s enrollment is in progress.  The same processes that occur with a manual child 
enrollment occur with the bulk enrollment file process.  

 

NOTE: When correcting records and re-uploading the file, be sure to remove the <Error or Status= column as it is 
not accepted for the upload.  Also, it is best to NOT include records that have already been submitted successfully 

as they will now error as having been processed.  When removing successful records and the Error or Status 

column, it is best to highlight the row/column and use the cut/delete option instead of just deleting the 

information.  Excel often retains formats even if the cells are now empty. 
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VPK-20 Contract Verification 
A provider must have a Certified VPK-20 contract on the Anticipated Start Date before an enrollment can be 

added. In the below example, the VPK application information is entered by the provider, and the + Enroll to this 

Class button is clicked.   

 

 

 

In this example, the provider does not have a Certified VPK-20 contract, so an error message displays, alerting the 

provider that the enrollment cannot be submitted.  
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Enrollments 3 SR 

Pending Family Acceptance Status 
When a new School Readiness enrollment is created for an eligible child, families must accept the terms and 

conditions, establish their consent for developmental screening and/or child assessment, and sign the payment 

certificate.  Families receive an email notification from OEL every five days until these steps are completed and the 

enrollment status changes from Pending Family Acceptance to Enrolled.   

 

New enrollments in Pending Family Acceptance will not be visible on provider attendance rosters and will only 

appear once the family signs the payment certificate; however, there are exceptions. 

÷ New enrollments for at-risk children (BG1) or at-risk children in relative care (BG3R) billing groups in 

Pending Family Acceptance will populate on attendance rosters 

÷ Existing enrollments in Pending Family Acceptance that have already been submitted for attendance in 

previous months will continue to populate on attendance rosters 

  

Providers will be able to process attendance and be paid for these enrollments, but not until the payment 

certificate is signed by the family.  

 

If a provider has new enrollments in Pending Family Acceptance, when the provider accesses SR attendance, a 

pop-up window will display with a count of those new enrollments and a link to the Manage SR Enrollment queue.   
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Viewing Enrollments in Pending Family Acceptance 

To view enrollments in Pending Family Acceptance, navigate to Enrollments > Manage SR Enrollments > 

View/Edit SR Enrollments.  

 

 
 

Then, enter <Pending= in the Status column filter. 
 

 
 

Ending Enrollments in Pending Family Acceptance 

Providers can end enrollments in Pending Family Acceptance. Search for enrollments in Pending Family 

Acceptance, as detailed above, then click the End Enrollment button.  
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A confirmation pop-up window displays. Click Yes to continue or No to stop the End Enrollment process.  

 

 
 

After clicking the Yes button, the following pop-up window displays. Complete the required information and click 

Save.  

 

 
 

After clicking Save, a confirmation pop-up window displays. Click Yes to end the enrollment or Cancel to cancel the 

End Enrollment process.  
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After clicking the Yes button, a pop-up window displays a message that the enrollment is ended. Click Ok to 

continue.  

 

  
 

Cancelling Enrollments in Pending Family Acceptance 

Providers can cancel enrollments in Pending Family Acceptance, but only if the enrollment is not for an at-risk 

child (BG1) or at-risk child in relative care (BG3R) and attendance has not been submitted for the enrollment. 

 

Search for enrollments in Pending Family Acceptance, as detailed above, then click the Cancel Enrollment button.  

 
 

 

 

   
 

Click Yes to cancel the enrollment and remove it from the SR Enrollment queue. Click No to stop the Cancel 

Enrollment process.  
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SR Eligibility Redeterminations 
The SR Eligibility Redetermination menu allows providers to view enrollments with <upcoming= or <past due= 
redeterminations. These queues are for informational purposes only and aid providers in knowing when an 

enrolled child is reaching the end of their School Readiness eligibility. 

 

Upcoming Eligibility Redeterminations 

To see the enrollments with upcoming eligibility redeterminations, navigate to Enrollments > Manage SR 

Enrollments > Redeterminations > Upcoming Redeterminations. 

 

 
 

Redetermination records will only appear in the Provider Portal Upcoming Redetermination queue when: 

÷ Child eligibility status is Eligible 

÷ Child enrollment status is Enrolled or Pending Family Acceptance 

÷ The redetermination is within 15 days from the due date 

 

Past Due Eligibility Redeterminations 

To see the enrollments with past due eligibility redeterminations, navigate to Enrollments > Manage SR 

Enrollments > Redeterminations > Past Due Redeterminations. 

 

 
 

Redetermination records will only appear in the Provider Portal Past Due Redetermination queue when: 

÷ Child eligibility status is Eligible 

÷ Child enrollment status is Enrolled or Pending Family Acceptance 

÷ The redetermination is at least one day past the redetermination due date 

 

 

 

After clicking the Upcoming Redeterminations or Past Due Redeterminations link, the following appears. 



 138 

 
 

Click the link for a child name in the Child Name column, and a pop-up message displays child eligibility and 

enrollment details for the child.  

Click View in the Payment Certificate column, and a pop-up message displays the payment certificate for the 

enrollment. If the payment certificate does not exist, the View button will not be active, but hovering over the 

button displays a message: "The payment certificate is not viewable until signed by the parent."  

NOTE: If the ELC changes the Household Eligibility Status from Redetermination to Active or Inactive, the child9s 
eligibility will be removed from Redetermination status and the record(s) will be removed from the Provider Portal 

Redetermination queues. 
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Temporary Closures 

Creating a Temporary Closure 
Temporary closures must be created when the whole site or program is temporarily closed due to emergency 

circumstances. Provider and Coalition users can initiate temporary closures.   

 

NOTE: Temporary closures must be created BEFORE attendance is submitted for the month in which the closure 

occurs.   

 

To add a closure, navigate to Attendance > Temporary Closures. Click the Temporary Closures submenu item. 

 

 
 

Click the Add Closure button.  
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The Report Temporary Closure pop up message will appear.  
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Complete the form. Hover over the information icons for additional information. 

÷ Temporary Closure Type 3 When an entire site is temporarily closed due to emergency circumstances, 

where all programs and children are impacted, select <Yes, the whole site was closed.  Services were not 
provided to any children.= 

÷ Closed Provider Site(s) 3 Select the site(s) that were completely, temporarily closed due to emergency 

circumstances.  Each site that the user has access to is listed.  NOTE:  If providers were closed for different 

dates, they should be unchecked and have separate closure events created.  

÷ Closure Details 3 Enter the closure date range. The <From= date is the first day of the closure and the <To= 
date is the last day of the closure. A single day closure would have the same <From= and <To= date. No 
services are rendered on dates included in the closure date range. NOTE: The closure date range is limited 

to a single month. If the closure crosses into the next month, you will need to create an additional closure 

to cover that time period. 

÷ Closure Reasons 3 Select the applicable reasons.  If the 8Other9 option is checked, enter comments. 

÷ Documentation 3 Click the Upload Document button to upload necessary documents (not mandatory). 

÷ Comments 3 Enter comments (Not mandatory). 
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Click the Save button to save the record.  The message closes and the record appears in the grid with <Incomplete= 

status. 

 
 

 
 

 

Editing a Temporary Closure 
To edit a temporary closure record, click the Edit button. The closures listed are specific to the provider site 

selected. 
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Edit the closure details and click Submit to Coalition.  

 
 

After clicking the Submit to Coalition button, the Sign and Certify message appears. Fill in the Sign and Certify 

fields and click the Submit button.   
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The record changes to Submitted status. 

 

Once the submitted record is processed by the coalition, the record changes to Processed status. 

NOTE:  

1. When the status of the record is Submitted, there is only a View button. The provider cannot edit or 

delete a temporary closure record that is in Submitted or Coalition Reviewing status. 

2. Only Processed records will have a value in the Payable field. 

3. Incomplete and Processed records can be deleted. 

4. When a coalition adds more providers to the closure that the provider user does not have access to, there 

will not be a Remove button. 

 

 

 

Updating VPK Class Calendar 
After the coalition processes a temporary closure, VPK providers have additional steps to complete the process.  

On the Provider Portal dashboard select Contracts > Manage Contracts or click the VPK Provider Application link 

under Common Tasks. 
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Click the Edit button for the VPK-APP.  

 

Click the VPK Calendars tab to open the calendar section. 

 

  



 146 

Click the Edit button to make changes to the calendar. Click the arrow to scroll to the particular calendar month to 

make edits/changes. 

NOTE: The system defaults to the first calendar month of the class. 

 

Select the desired emergency closure day(s) by clicking on the day(s) within the calendar. 

NOTE: Multiple days may be selected by clicking and dragging days. 
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After selecting a day, a pop-up will appear. There are two event types available. 

Instructional Day Exception 3 use if provider does not plan to make up calendar days for the emergency closure (up 

to 5 days permitted). 

Non-Instructional Day 3 use if provider plans to deduct the calendar hours for the emergency closure days and 

revise its class calendar to restore days. 

 

 

Instructional Day Exception 

For closures that do not reduce hours, select Instructional Day Exception as the event type. 
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Once the Instructional Day Exception is selected, the provider will enter a description and time range for the 

particular day(s) they were closed. In the image below, the description example uses the verbiage <Closed due to 
Hurricane Dorian.= The provider will have to choose the same time range for the days as they listed on their 

calendars. Any hours chosen outside of their Start and End times will change their total calculated hours. Click 

Update. 

NOTE: If the provider has different instructional hours per day, a separate exception day event should be created 

for each day (i.e. Mondays are 3 hours and Tuesdays are 3.5 hours) so that the exact hours of the instructional day 

are entered for the exception day event. 

 

  



 149 

The information is displayed on the calendar. The total calculated class hours and total instructional days have not 

changed. Click Save. 

NOTE: These steps must be completed for each impacted calendar. For example, some providers may have a 

morning VPK class using calendar A and an afternoon VPK class using calendar B. Since both calendars were 

impacted due to the closure, both calendars must be edited. 

 

When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature information 

and click the Submit VPK Provider Application button. 
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Non-Instructional Day 

For providers that will deduct the calendar hours for those days and revise its class schedule to restore days, select 

Non-Instructional Day as the event type. 

 

Once the Non-Instructional Day type is selected, the provider will enter a description for the particular day(s) they 

were closed. In the image below, the description example uses the verbiage <Closed due to Hurricane Dorian.= 
Click Update. 
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The totaled calculated hours will be reduced for each non-instructional day based on the hours defined for the day. 

Next, make the appropriate change to the calendar to add the make-up days. This can be accomplished in a variety 

of ways such as canceling previously identified non-instructional days, extending the class end date, or even 

extending the time on some instructional days (by creating exception days with different hours). When complete, 

click Save. 

NOTE: These steps must be completed for each impacted calendar. For example, some providers may have a 

morning VPK class using calendar A and an afternoon VPK class using calendar B. Since both calendars were 

impacted due to the closure, both calendars must be edited. 
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When all impacted calendars are updated, click on the Certify and Submit tab. Complete the signature information 

and click the Submit VPK Provider Application button. 
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Attendance - VPK 
Providers manage VPK attendance online by navigating to the Attendance menu item and selecting Manage VPK 

Attendance.  Providers may submit their attendance through the web page or using a bulk file upload, similar to 

the bulk enrollment file upload.  It is important to note that changes to enrollment, such as entering a termination 

date, or changes to the class schedule, such as reporting a site closure, cannot be performed in attendance.  

Enrollment information must be corrected in the Enrollments area.  Class schedule information must be corrected 

in the Contracts> VPK Provider Application area.  Any changes to source data should be done prior to submitting 

attendance.  Coalitions may assist as needed. 

 

Submitting Attendance Online 
Select the Manage VPK Attendance menu item.  The VPK Attendance Roster displays, defaulting to the current 

service period and first class.  The blue summary box to the right contains class details such as the class full name, 

start and end dates, and max class size.  If necessary, use the drop downs to select a different service period 

and/or class.   

 

NOTE: A service period is the month in which services were rendered.  Child absences for the service period must 

be marked, saved, and submitted to the coalition for payment.  A due date is displayed for each service period.  

Providers with multiple classes must submit an attendance roster for each class for payment.   

The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing 

group, or status).  The summary feature shows the current/saved attendance information for all children in one 

view. 
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To record attendance, click on a child9s name to view their attendance for the month.   

 

÷ Days the site is closed are marked with an asterisk <*.= 

÷ Days the child is scheduled to attend are marked with an <X= for present.   
÷ A legend is provided in the bottom right for more code descriptions.  

To change a present day to absent, click on the <X.=  The <X= for present will now appear as an <A= for absent.   

NOTE: Absences entered by mistake can be changed back to present by clicking on the <A.=   

While not required, it is recommended to click Save (below the calendar) before moving on to another child.  

When all child absences are marked for the month, click Save and then click the Submit to Coalition button.  A 

window may appear if the attendance is being submitted early or late, or if no absences have been recorded.  To 

continue to the Sign & Certify page, click Continue. 
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The Sign and Certify page displays the class summary with the total number of days absent and days present.  At 

this point, providers may want to print this page using the browser print function.  When ready, review the 

certification statements and complete the Authorized Electronic Signature portion by entering the user's Full 

Name, checking the box for Certify by electronic signature, and clicking Submit.  To abandon the submission, click 

Cancel.  

 

Submitted Attendance 

Upon submission, the screen returns to the VPK Attendance Roster view with the current service period displayed.  

Select the submitted service period from the drop down.  The submitted roster now has a submitted message and 

each child shows <SUB= for submitted in the status column.  This status will change as the child attendance is 
processed by the coalition. 
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Rejected Attendance 

Coalition staff may reject submitted attendance.  In this case, the individual that submitted the roster will receive 

an email notification.  Instructions are provided to log in to the Provider Services Portal, review the roster, make 

necessary changes to rejected records, and re-submit.  The rejected child records are displayed at the top of the 

roster list in red and show "REJ" for rejected in the status column.  Only records with "REJ" may be edited. 

 
 

To edit, click the name of a rejected record.  Any absences previously recorded appear.  Make changes as needed.  

After the last record is corrected, click Save.  Then, click the Submit to Coalition button and continue to the Sign & 

Certify page.  This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the 

coalition.  Complete the Authorized Electronic Signature portion and click Submit. 

 

 
 

Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."   
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Approved Attendance 

Coalition staff will continue to work submitted attendance until the records are approved for payment.  Approved 

records appear on the attendance roster as "APP" for approved in the status column.   

 
 

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under 

Attendance> Reimbursement Details. 

 
 

Uploading Bulk Attendance File 
Providers may submit their attendance via a bulk file upload (similar to the enrollment bulk file upload process).  

To begin, go to the Attendance menu item, choose Manage VPK Attendance, and then select Bulk File Upload. 

 

The Bulk VPK Attendance page displays. 

 

Click the CSV file template link.  A window appears.  From this window, select the service month and year to 

generate a file for all of the enrollments (for all classes) at the site that month.  Alternatively, multi-site providers 

may check the "Include all providers for provider principal" box to generate a file for all of the enrollments (for all 

classes) at all sites associated to the account for that month.  Then, click the Download button. 
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Open the downloaded file.  The enrollment information for each class is pre-populated.  Each instructional day 

during the student's enrollment defaults to present (X). 

 

 

a. Legend:  present (X), site closed (*), student not started (_), student terminated (T).  

b. Day_1 = first of attendance month, Day_2 = second day of attendance month, Day_3 = third day 

of attendance month, etc.  In this example, Day_1 = August 1, Day_2 = August 2, and Day_3 = 

August 3. 

c. Regardless of the month/year, columns for Day_1 to Day_31 are included in the file and are 

necessary for the upload; none should be removed. 

d. It is critical that only the content of "Day_#" columns are changed (i.e. changing an X to an A).  

Attempting to add students or edit/remove system generated columns will cause errors.  The file 

is a reflection of the enrollment information for the class when downloaded.  If issues are 

identified, please contact the local early learning coalition for assistance. 

Scroll over to the days and record absences by changing a present day (X) to absent (A).  Tip: (In Excel) Open the 

View menu, select column H, and click Freeze Panes.  This will keep the student's name and demographic 

information in view while scrolling through days.   
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(In Excel) When complete, un-hide and/or un-freeze any columns.  Click File> Save As.  Re-name file and save 

locally.  Be sure the file type is .csv. 

 

On the Provider Portal, click the Upload button.  A file manager window opens.  Locate the saved file and click 

Open. 

 

The uploaded file displays in the Bulk VPK Attendance log. 

 

Click the Refresh button to get final results. 

 

The successfully submitted attendance is now reflected on the class attendance roster.  Each record shows "SUB" 

for submitted.   
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Attendance - SR 
Providers manage SR attendance online by navigating to the Attendance menu item and selecting Manage SR 

Attendance.  Providers may submit their attendance through the web page.  It is important to note that changes to 

enrollment, such as entering a termination date, cannot be performed in the attendance module but rather the 

Manage SR Enrollment area.  Also, when issues appear on the attendance roster (such as incorrect enrollment 

information, missing children, duplicate children, missing paid holidays, duplicate absences on the same day, etc.), 

the issues should be communicated to the coalition before submitting the attendance roster.  Coalitions may assist 

in addressing the issues so that the attendance records have accurate information.   

 

Submitting Attendance Online 
Select the Manage SR Attendance menu item.  The SR Attendance Roster displays, defaulting to the current 

service period.  The blue summary box to the right contains provider details and paid holiday information for the 

service period.     

 

NOTE: A service period is the month in which services were rendered.  Child absences for the service period must 

be marked, saved, and submitted to the coalition.  A due date is displayed for each service period.  Providers that 

contract with multiple coalitions must submit an attendance roster to each coalition.   

Children that are <Enrolled= are included on the SR attendance roster.  
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New enrollments in <Pending Family Acceptance= will not be visible on attendance rosters and will only appear 
once the family signs the payment certificate; however, there are exceptions. 

÷ New enrollments for at-risk children (BG1) or at-risk children in relative care (BG3R) billing groups in 

Pending Family Acceptance will populate on attendance rosters 

÷ Existing enrollments in Pending Family Acceptance that have already been submitted for attendance in 

previous months will continue to populate on attendance rosters 

If a provider has new enrollments in <Pending Family Acceptance=, when the provider clicks the Manage SR 

Attendance menu item, a pop-up window will display with a count of those new enrollments and a link to the 

Manage SR Enrollment queue.   

 

See the Pending Family Acceptance Status section in this user guide for more information.  
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The search feature may be used to search for any criteria included in the roster (i.e. a name, DOB, age, billing 

group, or status).  The summary feature shows the current/saved attendance information for all children in one 

view. 

To record attendance, click on a child9s name to view their attendance for the month.   

 

÷ Days the site is closed are marked with an asterisk <*= 

÷ Days the child is not scheduled to attend are marked with <NS=. If the entire month for a child is 

marked <NS=, contact the local early learning coalition to correct the care days.  
÷ Days the child is scheduled to attend are marked with an <X= for present along with his/her 

scheduled unit of care 

÷ Paid holidays where a child is also scheduled to attend are marked with an <H=  
÷ A legend is provided in the bottom right for more code descriptions 

NOTE: The <Child9s Current Information= displayed on the right is current as of today.  When working prior months, 

the information displayed may not align.  For example, if a child9s enrollment was terminated in February 2019, the 
current enrollment status is Enrollment Ended.  Each month (prior to February) will also display Enrollment Ended 

in the <Child9s Current Information= area because it is the current enrollment status.  This does not impact the 

ability to record attendance for those prior months.  Enhancements are planned to address the display.   

To change a present day to absent, click on the <X.=  A pop-up message appears to collect more information. 

a. Select an absent reason from the dropdown.      

b. Include a message to the coalition regarding the absence in the Note area.  (optional for most reasons) 

c. Attach a file for supporting documentation by clicking Choose File.  (optional) 

d. Click Save when done and the pop-up message will close. 

e. The <X= for present will now appear as an <A= for absent.  
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f. NOTE: Consecutive absences must be entered per day (i.e. there isn9t a click and drag feature to select 
multiple days at once).  However, it is not necessary to upload the same document per day when it 

applies to multiple days.  Upload the document on one of the absences and reference it in the Note area 

for the other absences.   

g. Absences entered by mistake can be changed back to present by clicking on the <A.=  The below pop-up 

message appears.   

 

If there was a file attached when the day was marked <A=, the Remove button appears next to the 

document name.  Click the Remove button to remove the file.  To undo the absence, click the Remove 

Absence button. The day will show an <X=, the absence reason is removed, and the attachment is 
removed. 
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While not required, it is recommended to click Save (below the calendar) before moving on to another child.  

When all child absences are marked for the month, click Save and then click the Submit to Coalition button.  A 

window may appear if the attendance is being submitted early or late, or if no absences have been recorded.  To 

continue to the Sign & Certify page, click Continue. 

 

The Sign and Certify page summarizes the information for each child and an electronic signature is required.  
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Submitted Attendance 

Upon submission, the screen returns to the SR Attendance Roster view with the current service period displayed.  

Select the submitted service period from the drop down.  The submitted roster now has a submitted message and 

each child shows <SUB= for submitted in the status column.  This status will change as the child attendance is 
processed by the coalition. 

 
 

 

Rejected Attendance 

Coalition staff may reject submitted attendance.  In this case, the individual that submitted the roster will receive 

an email notification.  Instructions are provided to log in to the Provider Services Portal, review the roster, make 

necessary changes to rejected records, and re-submit.  The rejected child records are displayed at the top of the 

roster list in red and show "REJ" for rejected in the status column.  Only records with "REJ" may be edited. 
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To edit, click the name of a rejected record.  Any absences previously recorded appear.  Make changes as needed.  

After the last record is corrected, click Save.  Then, click the Submit to Coalition button and continue to the Sign & 

Certify page.  This time, the Sign & Certify page only shows the rejected records that are being re-submitted to the 

coalition.  Complete the Authorized Electronic Signature portion and click Submit. 

 

 
 

Upon submission, the rejected "REJ" records appear on the roster as submitted "SUB."   
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Approved Attendance 

Coalition staff will continue to work submitted attendance until the records are approved for payment.  Approved 

records appear on the attendance roster as "APP" for approved in the status column.   

 

 
 

When records are paid by the coalition, the reimbursement details are posted on the Provider Portal under 

Attendance> Reimbursement Details. 
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Request for Registration Fee Payment 
Registration Fee Payments can only be requested by a provider. To request a Registration Fee, navigate to 

Enrollments > Manage SR Enrollments > Registration Fees > Eligible for Payment 

 

 

Eligibility Rules for Registration Fee payments: 

÷ Children are/were enrolled during the 2020-2021 program year.  

÷ Children have not been paid more than 2 times in 5 years (or three with a hardship). Payments from 2019-

2020 are excluded. 

÷ Children with the BG1-ESS billing group and eligibility code are not eligible. 

÷ Children <dismissed= by the provider for payment for the program year are not eligible. 
÷ Children enrolled 3 months or less with expulsion reasons (Safety of Other Children or Behavior Problems) 

are not eligible. 

The Registration Fee Payments screen lists children who are eligible for Registration Fee payments. To request a 

payment, check the checkboxes and click Request Payment button.  
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On the Request Payment pop-up, check the I certify checkbox and click OK. The record will be available for the 

coalition to Approve, Reject, or mark Ineligible.   

 

 

Dismiss Children 
If the provider has collected the registration fee from the family, the child is not eligible for a registration fee 

payment. To dismiss children from the list of registration fee payments, check the checkbox and click Dismiss 

Children button. Hovering over the Dismiss Children button will display the following message: <Remove all 
selected children from this list and indicate that payment is not expected from the coalition.= 
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The Dismiss Children pop-up window opens. Click the OK button to confirm dismissing the child(ren) from the list 

of registration fee payments. The Provider won9t be able to resubmit these children for registration fee payment.  
 

 

 

 


